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INTRODUCTION

You’re in the middle of an important job interview, chatting comfortably with the

company’s board of directors and feeling good about how things have gone thus

far.  Suddenly, the company’s IT director turns to you with an evil glint in her eye.

“Our company only uses Macs.  Are you Macintosh-proficient?”  The room falls

silent as all eyes focus on you, and a bead of sweat rolls down your temple as

you contemplate how to explain that you’ve never really used a Mac…

To many PC users, this may sound more like a nightmare than a realistic

scenario.  However, many businesses, educational institutions, and even

informal places like Internet cafes are using Macintoshes.  In today’s competitive

job market and technology-filled world, people who cannot use both PCs and

Macs are in danger of being left in the digital dust.

Declaring yourself “Macintosh proficient” does not require becoming an expert in

the advanced inner workings of Macs or completing a lengthy training course.

Proficiency simply includes being able to move around in the interface and locate

programs, many of which operate similarly to PC versions.  By overcoming some

of the basic operational differences between Macs and PCs, PC users can feel

confident about encountering Macintoshes in their professional and personal

lives.
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OBJECTIVES

By the end of this tutorial, you will be able to:

…move confidently around the Mac’s desktop and menus.

…locate any program installed on the Mac.

…manipulate windows (close, minimize, maximize, resize, etc…).

…create desktop shortcuts.

…use standard, preinstalled Macintosh applications and install/uninstall

programs.

…access external storage devices (CDs, USB drives, etc…).

…use common Mac keyboard shortcuts.
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I.  BASIC PC—MAC DIFFERENCES

So, why would anyone use a Mac?  Wouldn’t the world be a simpler place if

everyone used the same kind of computer?  Macs and PCs both have dedicated

followers, and each type of computer has its strengths and weaknesses.

Manufacturers
Apple Computers is the only manufacturer of Macintosh computers.  However,

many different companies make PCs.

For this tutorial, let’s consider a PC to be a computer that uses the Windows

operating system.  Manufacturers like IBM, Dell, Gateway, Compaq, and many

others sell computers that come with Windows pre-installed.  PCs are much

more widely produced than Macs.

Processors
Macs and PCs have traditionally used different kinds of processors (although,

with the recent partnership between Apple and Intel, this may change soon).

Different processors can yield different strengths, and Apple has used this to try

and differentiate itself from the PC market.  Macintoshes use a more graphics-

based interface, while Windows is more text-centered.  Macs also offer powerful

graphic and video software, such as photo and movie editors, so their processors

are designed to enable these programs to operate quickly and smoothly.  PCs

tend to be less geared toward these areas.

Interfaces

The most noticeable difference between Macs and PCs is in the interfaces.

While many computer users will proclaim one or the other “superior” or “best,”

this is ultimately a matter of personal preference.  Some people simply prefer the

aesthetics of the Mac.  Many Mac users are not professional graphic artists or
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video editors; some people like the look and feel of Macintosh computers, inside

and out.

Price
PC advocates often complain that Macs are too expensive.

However, Apple has introduced several affordable

computers, such as the eMac and Mac mini series.  Also,

many Mac users will counter that they are getting more

power and capabilities than in a PC of the same price.  Users

have to weigh the cost, capabilities, and included software of

a computer to determine what brand and model will work best for them.

Compatibility
While Macs and PCs existed in disparate worlds for years, new programs and

efforts have increased compatibility.  Macs running Mac OS X Tiger, the newest

version of the operating system, can open PC files and coexist on local networks

with PCs. The recent announcement that Apple will begin using Intel chips also

signals that Mac—PC compatibility will only increase in the future.

Unfortunately, PCs have not made such extensive advances towards

compatibility.  Many computers using Windows cannot open files stored on

diskettes that have been specially formatted for Macs.  Also, PCs are unable to

open several file types specific to Macs.  If you will be using both a Mac and PC,

be sure to save files in formats that can be opened by both computers.

For more in-depth information on file types that transfer easily from Mac to PC

and an explanation of the file-conversion process, visit the overview of “Porting

Files Across Platforms” at Mike’s Sketch Pad, located at:

www.sketchpad.net/port8.htm.
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II. INTERFACE

The Desktop
Like a Windows interface, the Mac begins at the Desktop:

Depending on whether this is a new, previously used, or shared machine, there

may be one or many icons already here.  The Macintosh HD icon is always

present and will be discussed in the Locating Programs section (p. 17).

Icons can be dragged with the cursor to a new place on the desktop as on a PC.

New icons can be created on the Desktop, which will be discussed in the

Creating Aliases (the Mac term for shortcuts) section (p. 21).
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One of the first questions that PC users ask is, “Where is the Start bar?”  Instead,

Macs have a menu bar at the top of the screen.  The far right side of it is similar

to the System Tray on a Windows machine, displaying the time and icons of

other programs running in the background.  Here’s the right end of my menu bar:

Norton Antivirus is a program that scans the files on my computer for viruses.  I

can click on this small icon and a few options for that program will be displayed.

Remote Desktop allows other uses on my network to share selected files on my

computer.  Don’t worry if these icons aren’t on your menu bar or a few other

icons appear.  Each computer may have different applications running in the

background.

The next two items will always appear on the menu bar.  Click on the small

speaker and a slide bar will appear; this allows you to change the system

volume.  To the right, the day of the week and time are displayed.  Click on the

day and time to change the format in which it’s displayed.

The small magnifying glass on the far right is Spotlight, a program new to Mac

OS X Tiger.  It allows you to quickly search for applications and files.  Spotlight

will be discussed more later (p. 20).

Apple Menu
At the far left side of the menu bar is a small apple icon.  Click on this,

and notice that “Sleep,” “Restart,” and “Shut Down” are three options
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near the bottom of the menu.  You will return to this menu and click on these

when you want to reboot or turn off the computer.  See the “Turning On/Off the

Computer” section (p. 23) for more information.

The Dock
The Dock is an area where you can place frequently used icons for easy access.

More than likely, the bar appears at the bottom of your screen, although it can be

modified to reside on the left or right side.  Some Macs also have the Dock set to

“hide” when it is not in use.  If you don’t see it, place the cursor at the bottom, left,

or right of the screen for a few seconds to “unhide” the Dock.

Place the cursor over any icon and the name of the program will appear above it.

To launch a program, click once on the icon.  A small black triangle will appear

below the icon to indicate that it has been launched.  Be patient; it may take

several seconds for a program to start.

To rearrange the items in the Dock, simply click and drag the icon to a new

location.  You’ll notice the other icons move to make room for the icon in its new

position.

Creating new icons in the dock will be discussed in the Finder (p. 14) and

Creating Aliases (p. 21) sections.

The most common programs appearing in the dock will be discussed in the

Software section (p. 27).
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System Preferences (the Mac Control Panel)
“System Preferences” is the Mac version of the Control Panel.  You

can find the icon in the Dock, and it’s also listed in the Apple Menu.

System Preferences allows you to adjust the settings for different

areas of the Mac from one convenient place.

The System Preferences window groups the settings menus under five areas:

Personal, Hardware, Internet & Network, System, and Other.  The “Other” area

displays settings for personally installed programs such as, in this case, Norton

AntiVirus.

Some of the most commonly used items in System Preferences are:

Desktop & Screen Saver: allows you to change the Desktop’s wallpaper

and the screen saver (more about your aesthetic preferences than

computer operation).

  Print & Fax: set up or reconfigure your printers and fax machines.
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  Sound: adjust system input and output volumes.

  Universal Access: configure the computer for users who are seeing,

hearing, or mobility impaired.

Trash

In Windows, the delete key can be used to remove files, icons, and folders that

are no longer needed.  This doesn’t always work on a Mac, especially with items

on the Desktop.  Instead, everything you want to delete should be placed in the

Trash.

In Tiger, the Trash icon is located on the far right side of the Dock.

Like the Recycle Bin in Windows, files that are placed here are not

automatically deleted, so don’t worry if you accidentally throw out

something important.  To retrieve a file, click on the Trash icon and its contents

will appear in a window.  Drag the item you want to retrieve onto the Desktop or

back to its original folder.

The Trash needs to be emptied every so often to free up disk space.  If you’re

sure you want to delete everything in the Trash, right click (see below) on its icon

in the dock.  Select “Empty Trash” to permanently delete its contents.

What if I need to right-click?  I only have one mouse button!

To “right-click” on an item, press the control key while clicking on the item.  It’s

that simple.

If you prefer, you can replace the Mac mouse with a dual-button mouse.  For

example, here in the lab, I’m using a Mac with a Dell optical mouse.  The mouse
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has two buttons and a wheel for scrolling, and the Mac recognizes all of the

buttons.
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III.  WORKING WITH WINDOWS

Macintosh windows can be controlled just like those on a PC.  However, the

buttons and menus have a slightly different layout.

Closing, Minimizing, Maximizing
Open any window.  Let’s click on the Trash, since we’ve already discussed it.

The window that opens is a common Mac navigation window, similar to Windows

Explorer.  Some of the window’s buttons will be discussed in detail in the “Finder”

section, but let’s focus on the three buttons on the very top left.

These buttons may not show up in color until you place the

cursor over them.  The buttons operate similarly to those on a

PC.  “Close” will close a window, although it will not exit the

program.  Even if all of the windows of a program are closed,

the application may still be running.  Look at the menu bar and see if the

program’s title still appears in bold on the left side.  If it is, click on the program

title and select “Quit program.”  For more about program menus, see the Menu

section (p. 12).

Even if the program’s title doesn’t appear on the menu bar, look at the Dock to

make sure that it’s closed.  Locate the program’s icon (if you don’t see it, you’ve

already exited the program).  Right-click on the icon and examine the menu.  If

the program is open, the last item on the menu will be “Quit.”  Select this to

completely exit the application.

“Minimize” will minimize a window that you don’t want to close but need out of the

way.  A small representation of the window will appear in the right side of the

Dock near the Trash.
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“Maximize” does not always make a window fill the entire screen.  Some

programs have a maximum window size that is not full-screen.  For example, in

Microsoft Word, when I click on the maximize button on my document’s window,

the window becomes larger but does not fill the screen.  If you don’t like the size

and placement of the window after hitting “maximize,” hit the button again to

return the window to its previous size and location.

Resizing and Moving Windows
Look at the bottom right corner of the window.  Below the scroll bar (which

operates just as on a PC), you’ll notice a triangle made up of four lines

(see left).  This is used to resize the window.  Click on the triangle and

drag it to adjust the window’s size and shape.

Moving a window is very easy.  Simply click on the title bar at the top of the

window and drag it to a new location.

Menus
On a PC, each application and folder has its own menu.  Macs operate slightly

differently.  The screen will always display only one menu bar, found at the top of

the screen, which changes depending on what program you are using.  Before

any programs are launched, the menu should say “Finder” just to the right of the

Apple.  This is actually a program that you will learn more about in the “Finder”

section (p. 14).

When a new program is opened, “Finder” will change to the name of the

application you’ve chosen, such as “Word” or “Safari.”  The available menu

options will also change.
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For example, when I launch Safari, an Internet browser, new menu items like

“History” and “Bookmarks” appear that are specific to the program.  These

menus operate just like those on PCs.

To display the original Finder menu again, click on an empty space in the

Desktop.  Clicking on a window running your program, such as a Safari web

page, will display that program’s menu.

• What are these crazy symbols beside the menu items?
PCs have keyboard shortcuts in certain programs.  For example, briefly pressing

the control key and the P key together is often a quick way to print something.

Control-S often saves an item without having to click on the File menu and then

Save.

Macs also have quick ways to perform certain program tasks.  The strange

symbols beside some menu items tell you what buttons will quickly repeat that

item.  For example, I frequently use the thesaurus in Microsoft Word.  I’d like to

know how to quickly run the thesaurus without clicking on the Tools menu then

“Thesaurus…” every time.

Take a look at part of the Tools menu:

The strange symbols to the right of “Thesaurus…” tell us the keyboard shortcut.

Briefly hold the keys and letters listed together, just like on a Windows machine.
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 refers to the apple key (also called the command key).  Look at the keyboard

between the space bar and the option/alt key; you’ll see a key that has an apple

and this symbol on it.

 refers to the option/alt key.  Find it beside the control key.

 refers to the shift key.

So, our shortcut for the thesaurus is option + apple + R.

Hiding Programs
An easy way to minimize all of the windows of a program is with the Hide

function.

Suppose you have five or six Word documents or Internet sites open that you’ve

been working with.  You want to minimize all the Word windows to get them out

of the way temporarily.  Instead of going through each window and minimizing it,

go up to the program menu (in this case, Word).

The fifth item down is “Hide Word.”  Click on this to

minimize all of the Word windows that are open.

Nothing has been deleted or closed; click on the Word

icon again in the Dock to reopen all of your windows.

Notice that “Hide Others” is another option.  If you are

working in Word or another program, windows from

other applications running in the background may

become a nuisance.  “Hide Others” will minimize all of

the windows except for those of the application you’re currently using.
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In every program, clicking on the title menu item (in boldface and the same name

as the current application) will give you the “Hide Program” and “Hide Others”

options.

Exposé
Exposé is a program that allows you to quickly view and hide windows.  The

program is always running; you will never have to click on an icon or locate an

application file.

• View All Windows

Perhaps you want to view all of the windows you have open simultaneously.

Press the F9 key.  Exposé will tile small representations of all the currently open

windows.  Place the cursor over each window, and the name of the program or

file will be displayed.  Click on a window and that program will come to the

forefront.  F9 is useful for moving quickly between applications when you have

many windows open.  Press F9 again to return to the window you were using.

• View One Program’s Windows

Press the F10 key.  This will display all of the windows of the program you’re

currently running.  For example, I’m using Microsoft Word.  If I press F10, Exposé

tiles all of the Word document windows that I have open.  I can easily see what

documents are open and click on the one that I need to use.  Windows for other

programs remain unmoved in the background.  Press F10 to return the windows

to their previous locations.

• Hide All Windows

At times, you may need to hide all of the windows that are currently open.  This

can be helpful for locating items on the Desktop that often become hidden behind

application windows.  Press F11.  This will move all of the windows to the edges

of the screen; you will only see a small sliver of each.  However, they have not



Introduction to Macs for PC Users 16

been resized or changed.  Press F11 again or click on the small visible edge of a

window to restore all of the windows.

To tailor Exposé to your personal preferences, look under System Preferences

and “Dashboard & Exposé.”  Rather than relying solely on the

function keys, you can set each corner of the screen to perform a

different Exposé task, such as viewing all open windows.  To

activate the screen corner controls you’ve selected, move the cursor into the

farthest point of the corner.  To continue working, click on a window or the

Desktop.
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IV.  WHERE ARE ALL THE PROGRAMS?!?

Many of the Mac’s common programs can be launched from the Dock.  However,

not all programs are listed here.  There are several methods of finding programs

that do not have an icon in the Dock or on the Desktop.

Macintosh HD:

The first (and possibly only) icon you’ll see on the Mac desktop

is labeled “Macintosh HD” (HD stands for hard drive).  It’s

usually in the upper right corner and is similar to the “My

Computer” icon in Windows.  Double-click on the icon to open a

window that allows you to navigate to various folders on the hard drive.  Click on

“Applications” in the far left column and a list of installed programs will appear.

Another way to arrive at this screen is through Finder, which we’ll explore next.

Finder:
Finder is similar to Windows Explorer.  To open Finder, click on its icon in the

dock, usually located on the far left:

This should take you to the same window as the “Macintosh HD” icon,

although it may have a different folder highlighted.  In this case, mine

has my username highlighted for quick access to my documents,

pictures, etc…
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The Finder window is an easy way to get an overview of what programs are

installed on the computer.  Click on the “Applications” folder on the far left and

let’s take a look at it.  Notice that, like a Windows machine, the Mac’s files are

organized in a system of folders.  Also, an icon represents every folder, file, and

application.  Let’s try to find a common program that Windows users need:

Microsoft Word.

• Navigating Folders
First, we may need to adjust the manner in which the program displays the files

and folders.  Take a look at the buttons in the upper left corner of the window.

Like Internet browsers, Macs have “back” and “forward” buttons within folder

navigation windows.  This makes returning to previously visited folders quick and

easy.
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As on a PC, files and folders can be displayed as large icons or in a list,

depending on your preference.  Macs can also display a series of folders and

subfolders in one window using columns, which I find to be the easiest way to

locate what I need.  Click on the “columns” button.

The “actions” button offers some common operations performed in file folders,

such as “New Folder” and “Get Info.”  Highlight an item in the window, click on

the action button, then “Get Info” to see a file or folder’s properties.

Now, let’s search for a program in Finder.  Make sure you’ve clicked on the

Applications folder on the far left; a list of the programs installed on the computer

should appear to its right.  Some applications may be buried in one or two layers

of folders, such as Microsoft Word.  To locate it, I’ve scrolled through the list and

clicked once on “Microsoft Office X,” a folder.  (I can tell that this is a folder

because of the small grey arrow beside it.)  This will open a list of this subfolder’s

contents to the right.  Here we can see Excel, PowerPoint, and Word among

other Office applications and folders.
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When I double click on the Word icon, it launches the program.  Clicking on the

icon once displays information about the program to the right.  The large program

icon in the far right column of the window can be dragged with the mouse to the

Dock, where a shortcut to the program will appear.  You’ll notice the other Dock

icons scoot out of the way to make space for the new item.  Now, you will be able

to launch Microsoft Word from the Dock without hunting for it every time.

Spotlight
In the upper right corner of the menu bar is a small icon with a magnifying glass.

This is Spotlight, a program that can search for programs, files, and folders

quickly.  Click on the icon and a text box will appear below.  Let’s search for

Microsoft Word, so type that in the box.

Our search returned a large number of hits

(600!), but notice that Spotlight has accurately

predicted which item we need in the “Top Hit”

area.  Applications are listed first, and other

types of files appear below (“Documents” and

“PDF Documents” here).  To launch a program

or open a file, click once on the item.  If what

you need appears but Spotlight is still

searching, go ahead and click on your item;

you don’t need to wait for Spotlight to finish.

To adjust what type of results Spotlight returns

and how it displays them, click on “Spotlight

preferences…” at the bottom of the result list.

Anytime you come across a folder or application with the magnifying glass

symbol beside a text box, it can be used to search for files within the program.
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For example, the Finder window has a search box on the upper right side.  Click

here to search for items within the Finder program.

Creating Aliases (a.k.a. shortcuts)
On a Macintosh, desktop shortcuts are called “aliases.”  It would be entirely

possible to create all of the Mac’s folders on the Desktop, eliminating the need

for aliases.  However, once a large number of folders had built up, the Desktop

would be cluttered and locating items within the folders would become difficult.

Maintaining an organized system of folders and subfolders (for example: a

Documents folder could contain Work and Home folders) makes finding items

easier.  Also, the Desktop now only contains very important and frequently used

items, making them easier to find.

We’ve already discussed how to create an icon in the Dock in the “Finder”

section (p. 17).  Let’s see how to make an alias on the Desktop.

I frequently use the Tutorials folder where I store all of my materials for creating

tutorials.  I’d like to make an alias on the desktop for this folder so I can open it

quickly.

First, I’ll open Finder and navigate to my folder.  Now, I’ll hold down the apple key

and the option/alt key as I click on the folder and drag it to the

desktop.  As I’m dragging it, I see a small black arrow in the

bottom left corner of the icon.  When I release the mouse and

keys, I’ve created a handy shortcut called “tutorials alias.”  Notice that the icon

still has a small black arrow in the lower left corner, denoting an alias.
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I can also create aliases for applications in the Dock.  They are made in exactly

the same way, but I drag them to the Dock instead of to the Desktop.  Program

aliases that have been created on the Desktop can also be dragged directly into

the Dock.

Note that aliases for folders and non-application files (those that don’t launch a

program) cannot be placed on the left-hand side of the Dock.  They can only be

placed on the right, near the Trash.  A thin black line divides the Dock into left

and right sides.  Here, I’ve placed my “tutorials alias” folder in the Dock next to

the Trash.
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V.  HARDWARE

Turning the Computer On/Off
Like a PC, a Mac has a power button on the CPU (the main unit).  Press the

button to turn on the machine.  The button may be different colors depending on

your particular machine, but it will always have a certain symbol on it (a circle

with a line emerging from the top).  It may be somewhat difficult to find because it

is the same color as the CPU, but keep looking!

On a PC, the “shut down” command is under the Start menu.  On a Mac, this

command is found in the Apple menu.  Click on the Apple in the uppermost left-

hand corner of the screen.

Take a look at the last few items in the menu.

“Sleep” allows the computer to save energy

without completely shutting off; press any key

on the keyboard to wake it up.  “Restart” and

“Shut Down” are self-explanatory, but you

should use the menu commands.

“Log Out” is useful if you are on a network

computer.  For example, here in the lab, I will

not turn the computer off when I’m finished

using it.  Instead, I’ll click on “Log Out Darby” so that someone else can use it.

Many labs and areas where computers are shared will ask that you log out

instead of shutting down the computer.
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If your Mac freezes or crashes and you can’t access any menus, the power

button on the CPU can be used to turn off the machine.  Press the button and

hold it down and, after around 5-10 seconds, the Mac will turn off.  This should

only be done when the Apple menu can’t be opened!

Loading/Ejecting CDs
Many Macs don’t have an eject button on the CD drive.  Instead, the drive can be

opened by a key on the keyboard and, sometimes, by a button within a software

program.

Take a look at the number pad on the right side of the keyboard.  Above the

usual number pad keys are four buttons.  The first three control the

system volume.  The key farthest to the right is the “eject” key.  Push it

to open and close the CD drive.

This symbol will sometimes be seen within various applications.  For example,

iTunes has an “eject” button in its interface that can be used to open and close

the CD drive.

USB Ports
A variety of different devices, from a mouse to a digital camera, can be plugged

into a Mac.  Most of these connect to the computer via a USB port.  USB stands

for Universal Serial Bus, and it is truly becoming “universal” as more and more

devices use this type of connector.

USB cables and ports generally have the USB symbol on them:

Take a look at the connecting end of a USB cable.  This is the end that will plug

into the computer:
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Image courtesy of HowStuffWorks.com

Flash drives (also known as “thumb drives”) also plug into USB ports.  These

relatively new small storage devices store a large amount of data and access it

quickly.  Just plug the drive into a USB port, and the Mac will automatically

generate an icon for it on the Desktop.

Image courtesy of BestBuy.com

Other types of external storage devices can also be accessed via a USB port.

Firewire drives and Zip drives can store even more information than flash drives,

but they still connect to the computer through the USB port.

PCs generally have USB ports on the back of the CPU (the main “box” of the

computer).  Macintosh has tried to make USB access more convenient.  Some

newer Macs have one USB port on the front of the CPU.  Some Apple keyboards

have ports on the back or side corners; no more crawling under the desk and

struggling to find the port!
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Image courtesy of Apple.com

Some USB devices that require a great deal of power won’t work properly when

plugged into the keyboard.  If this happens, locate the USB drive on your CPU

(there will be at least one).  These ports can handle more power-hungry devices.



Introduction to Macs for PC Users 27

VI.  COMMON MAC SOFTWARE
Macs come with a large number of preinstalled programs.  If you are familiar with

these programs, you can easily accomplish almost any task on a Mac.  Many

programs standard on PCs, such as Microsoft Word and Internet Explorer, are

also often installed on Macs.

This tutorial is not the place for advanced instructions on each program.

However, it will provide a basic introduction to programs commonly appearing in

the Dock to show you what they can do and give you enough information to

explore them.  The iSchool provides a variety of tutorials on specific software.

Consult our tutorial list at www.ischool.utexas.edu/technology/tutorials for more

in-depth coverage of many of the programs mentioned here.

Safari
Safari is the Macintosh Internet browser.  Many Macs also come with Internet

Explorer, but Safari most commonly appears in the Dock.  Its icon is

a silver compass (see left).

The program operates much like Internet Explorer or Netscape.  URLs are typed

in an address box at the top of the screen.  Back, forward, and reload buttons are

found in the top left corner.  Explore the menu and you’ll see that you can

bookmark pages and organize these shortcuts.

One difference between Safari and other browsers is that there is no animated

icon in the upper right corner of the window to show when the browser is working

on loading a web page.  Refer to the status bar (the grey bar running along the

bottom of the window) or the address bar (which will gradually fill with color as

the page is loading) to determine the browser’s progress.

Mail
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“Mail” is the Mac’s default email program, similar to Outlook Express

or Outlook on a PC.  It can be setup to check remote email accounts

through your Internet provider or to check a .Mac email account.  To

ensure you have the correct email settings, check with your service provider.

If you’re using an iSchool email account, the mail settings are:

Incoming Mail Server: mail.ischool.utexas.edu

User Name: your iSchool account user name

Password: your iSchool account password

Outgoing Mail Server: mail.ischool.utexas.edu

Messages are organized in a familiar folder format.  Common folders like Inbox

and Sent are present.  Compose, reply, delete, and other standard tasks have

buttons at the top of the screen.

Dashboard
Dashboard is a new addition to Mac OS X Tiger.  Click on the

Dashboard icon in the Dock and a number of small programs will

appear.  The most common ones are a clock, weather forecast, and

calendar, although many others can be used.

Each program is called a “widget.”  Click on the plus sign in the bottom

left corner of the window while Dashboard is running to view all of your

available widgets.  To place a widget on your dashboard, simply click on it and

drag it to your preferred location on the desktop.  Click on the small X in the

upper left corner of a widget to remove it from the dashboard.
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Widgets are moveable and interactive; for example, click on the weather widget

to view or hide a six-day forecast (note: you will need to be connected to the

Internet for this to work).

To hide Dashboard, click on an area of the screen behind the widgets.

Hundreds of Widgets for both business and recreational use are available from

Apple and other creators.  Go to www.apple.com/downloads/dashboard to

browse and download available Widgets.

Address Book

Mac’s Address Book allows you to keep track of virtual “business

cards.”  You can store names, addresses, email addresses, phone

numbers, etc. in one convenient place.  Address Book integrates with

Mail to provide email addresses.

iCal
iCal is a calendar program that can be used to keep track of

appointments by day, week, and month.  The program offers multi-

colored labels for easy organization.  You can also create to-do lists

and event reminders.
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iTunes
iTunes is Macintosh’s default music player.  It can be used to play

audio CDs and music files in a variety of other formats.  Tracks are

played and adjusted with familiar stereo controls.

iLife Suite
The iLife Suite ’05 Suite includes iPhoto, iMovie, iDVD, GarageBand, and iTunes.

The suite is preinstalled on Macs running OS X Tiger.  Icons for the programs will

appear in the Dock:

• iPhoto lets you organize and edit your digital photos.  You can also create

photo slideshows.

• iMovie is a tool for creating movies using your camcorder.

• iDVD allows you to create menus for homemade DVDs.  Design your own or

choose from a variety of included themes.

• GarageBand is essentially a personal recording studio.  Create computerized

tracks, record yourself playing instruments or singing, and mix all of the

elements to create musical tracks.

• iTunes can copy tracks from CDs to the hard drive for use in movies, menus,

and slideshows.

For more in-depth information about iPhoto, iMovie, and iDVD, visit the iSchool’s

tutorials about these programs at:

www.ischool.utexas.edu/technology/tutorials/graphics_tutorials.php
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VII.  COMMON KEYBOARD SHORTCUTS

Force quit – Apple + Option + Esc

Right click – Control + mouse click

Create alias (shortcut) – Apple + Option + Click and drag with mouse

Cut – Apple + X

Copy – Apple + C

Paste – Apple + V

Exposé Shortcuts
F9 – View all of the windows that are currently open

F10 – View all of the windows of the program that you’re currently using

F11 – Hide all windows

For more keyboard shortcuts and terms for Windows users, go to the Finder

menu, open the Help menu, and click on “Mac Help.”  Here, you can find more in-

depth information about “Switching from Windows.”


